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QuickGuide: PMIS - Setup and Processing for
New Users

This guide provides new users with the necessary steps to begin using the Position Management
Information System (PMIS).

Set up Human Resources Current Year Payroll Tables

1. Review and/or update job codes.

Personnel > Tables > Job/Contract > Job Codes

Before beginning this process, consider the existing job codes in the current year payroll. It is
important that there are no changes made to the existing job codes that are already assigned
to employees in the current year; however, you can add new job codes to the table.

JOBCODES — CONTRACTCLASS — CONTRACTTERM  CONTRACTYEAR  EXTRACTID  TERMINATION REASOM
(== ) =
Delete  Job Code fob Deseription EEOC Code Accout Code ‘Salary Concept Inc

(o000 ] [sUBSTITUTE TEACHER | w [ - g [Aus= rytable W |
(o020 ] [HOURLY HOLIDAY PAY ] [18Service workers | [129-51-6120.00-390-2-99-0-[] | (D Us= hourlyidaily rat= tabl= W |
[ o100 ] [SUPERINTENDENT ] [oLOffcial sdminmar ] [ -- - ---- ] 1 [DUs= hourlyidaily rate table W ]
(o101 ] [INTERIM SURERINTEMDENT ] (0L Officiol sdmin mar ] [RMM-MH00000CRMM-K200%] | [ Use hourlyidaily rate table W
[(0113 | [assisTanT supsRnTENDENT | [210 nmgr W] [ -- - - -- ] 1 [DUs= hourlyiaily rate table W |
[[0115 ] [BUSIMESS MANAGER ] [0lOffcial sdminmgr %] [ - - .- ---- ] 1 [DUse hourlyidaily rmt= tmble W |
[(o116 | [cummicuLum DIRECTOR ] [orom ] 1 [Ous= hourlyidsily rate tasle W
(o120 ] [ADMIMISTRATIVE ASST ] [oroe x0en] 7 [DUs= hourlydai )
[ o121 ]| [DIRECTOR SPECIAL PROGRAME] [O1 KN g

[(o1zz ] [DRecToOR FOODSERVICES | ] 1

[(o135 ] [mReCTOR. sPECIAL EDUCATICH] | 1

((o1ze | [racmaToR/DAER | ] 3 [Bf== oy table W |
o1z | [ADMINCOMEDEATT ] ] 1 [al=e ry table W |
(30 ] [ocsmesr ToHR ] (07 Dther classmm teach o] 1 [l = )
[[0133 ] [SUPERVISOR, VOC EDUCATION | vl [-- - ] 1 [AUseannuslzolarytablz W ]

»

23 [ | [Lam Add

For LEAs that accrue, each job code can only tie to one accrual code. You may need to perform
maintenance to ensure a good starting point. For example, if a job code is set up for a teacher
and you have employees with 187 work days and employees with 197 work days tied to that job
code, a new job code should be added so that an accrual code exists for both sets of
employees. Do not make changes to existing job codes that are tied to employees, changes can
be made when creating positions.
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If the LEA expenses workers' compensation, it is important to set up those codes on the job
code table. If workers' compensation codes are not established, expensing will not occur for
that position. For each position, the workers' compensation code is retrieved from the job code.

2. Update salary tables.

When using Position Management, all employees must be tied to one of the following salary
tables:

Personnel > Tables > Salaries > Local Annual - Contracted employees

LOCAL AMMUAL ~ HOURLYDAILY  EXTRADUTY  FUNDTOGRANT  STATEMIMIMUM  SUBSTITUTE  MIDPOINT

jr}E'n:e[W] | Retriewve | | Print

oy Stepe | AL W

Delete Pary Grade Pay Step Max Diays Employed Local Sched Anrual Amt

1) [ aoa ) 28 1 [ 1B i | [ 7203303

[ e ]| 0 ] [ oz ] | | [ 4e37Les)
[ iR ]| o1 T 276 |- K | | 0.435.00]
[ e ]| 02 ] [ oz ] | ] [ soaeses
[ 2 ][ o ]I [ 27 ] | | [ 4ma7ires]
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[ em ]| a0 M == [ ] [ 7076218
C=JC e =] | ] [eomom
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Personnel > Tables > Salaries > Hourly/Daily - Contracted and Non-contracted employees
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LOCAL AMNUAL  HOURLY/DALY  EXTRADUTY  FUND TOGRANT  STATEMINIMUM  SUBSTITUTE  MIDPOINT
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Personnel > Tables > Salaries > Midpoint - Contracted and Non-contracted employees

If your LEA has employees who are not tied to a salary table, it may be helpful to create a
midpoint table. For instance, if all LEA employees are assigned to a pay scale except for
cafeteria workers and bus drivers, whose salaries vary, it can be difficult to maintain a
consistent table setup. In this case, you can set up a midpoint table with different pay grades
for each job and then assign employees to that table.

TIP: Consider grouping “like” jobs when setting up the midpoint table.
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LOCAL ANNUAL ~ HOURLY/DALY — EXTRADUTY  FUNDTOGRANT — STATEMINIMUM  SUBSTITUTE  MIDPOINT
Pay Type: [BL_w |
Delete  Pay Grade Eay Type Mlinimueny Maciemum Micipoink Hours Dock Rate Type
[ oFc | [FHourlyemployee W ] [ 7.250] | EEED E N 0.00] | [H - Hourly W |
[ mz ] [tContractsdemployes %] [ 163480] [ Z20000) [ an74s] | oo0] (O-Deily ]
[ ] [LCantracted smglayes w# ] [ 1e3.200] [ 2n000) [ 190.745] [ 0.00) [D-Daily ]
1P IHourly emplayes W] | asoo] [ azan) | 1z000] [ .00] [H-Hourly %
[ 210 ] [Conwactedemployes ] [ 2zes20] [ 31ete0) [ 271400] | oo0] [D-Deiy W)
( e6z0) [ alelan] [ z7lamd] | 0.00] [D-Daily ]
[ ws1o] [ ag70) | 12530] [ .00 [H-Hourly w
[ 211 ] [LcConwactsdemglayes %] [ z47020) | 3a4640] [ zose3n] | 0o0) [0-Deily ]
[ 3FG | [FHouwlyemployee W] [ 11510] [ gomn] [ 1=730] [ 8.00] [H-Hourly % ]
[ #13 ) [LConwactsdemplayes w] [ 2em2s0] [ 3rseso] [ 322.4s0] | 0.00] [D-Daily w)
[ 4rc ] [3Hourlysmglayee ] [ 12730 | 7750] [ 15.240] | 2.00] [H-Hourly %]
[ eanon] [ annmsn) | as020] | ooo0| [D-Daily
([ zemomo] [ 4o1asn) [ 1] [ 0.00) [D-Daily W)
( ze20e0) [ anLesd) [ 5020 [ 0.00) [D-Daily ~)
zezoo0] [ aoreso] [ as.020] | 0.00] [D-Daily
O Click +Add and enter the following information:
o Pay Grade
o Pay Type
o Minimum - The lowest daily pay rate an employee would receive in this pay grade/pay
type.
o Maximum - The highest daily pay rate an employee would receive in this pay grade/pay
type.

O Click Save. The Midpoint is automatically calculated.

3. Update school calendar.

Personnel > Tables > Workday Calendars > School Calendar

All positions must be tied to a school calendar code. Existing school calendar codes can be
used. If there are positions that do not follow the existing calendar codes, you can add new
calendar codes. Calendar codes can be alpha or numeric.

It is important that the begin and end dates match the calendar. For example, when entering
the begin and end dates, many LEAs use 7/1-6/30 for 12-month employees. If 7/1 and/or 6/30
fall on a weekend and your calendar has a begin date of 7/2, then the employee's begin date
should be 7/2.
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SCHOOL CALENDAR ~ COPYSCHOOL CALENDAR  DELETE SCHOOL CALENDAR

a c T |Loumay | T = m
o 5 MT [zsomMa0 | 261 _
0 E NC (127 LBRARY AIDES ] 197

0 5 NC [127 LERaRY 2IDES | 197

o) E FC (220 2dmin |

o] 5 PC [220 Admin ] 220

] E PR (207 _start ] 207

0 5 PR [z07 start ] 207

O E TC [127 Staf ] 187

O 5 TC [187 stafe ] 187

o E TR [TRS WORKDAYS ] 187

0 B TR [TRS Cal | 261

] 5 TR [TRS WORKDAYS ] 187

0 4 R [Trs | 253

”
Add

4. Set up next school year pay dates.

Payroll > Tables > Pay Dates

Pay dates can be created for the next school year. The current year dates are used at this time,
but the pay dates for the next year must be set up prior to rolling positions to the next year
Position Management.
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Selected Pay Date
Addjustmant Mor Date Pay Run Interface User ID
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Set up District Administration Options

1. Update PMIS district options.

District Administration > Options > Position Management

This page is used to create and maintain Position Management options including the types of
calculations that should be used in Position Management and the specified default values to
be used for certain types of Position Management transactions. These options are not
typically changed throughout the school year.
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District Options

Use PMIS:
Unernplayment Eligible:
FICA f Medicare Eligible

Use Forecast Conversion Tables

Allew CYR Position Description Changes (Admin only)

Allgw Forecast Position Description Changes:

Payment Options

Round Salary to Nearest Whole Dollar

During CIC Calculation. Pay Onc-Time Supplement

Ermployes Must Be Assigned o Position Priof to Creating Payroll Record:

Display Options to lgnare Pt of Day and Pet of Year for Position Records:

B &

0O&8 &

Current Year
Mext Year: 200

Minémum Foundation Year

Default Position Recond Status: I_'.' - Vacant] st position info, ready o Sl emp) li]

O Verify that the following fields are completed and accurate:

o Current Year
o Next Year

o Minimum Foundation Year - Type the four-digit current or next school year in the YYYY
format to allow the system to select the corresponding tables to calculate the state
minimum salary amount. If this year matches the current year value, the current
Personnel state minimum table is used. If this year matches the next year value, the next
year Personnel state minimum table is used.

2. Set up category codes.

District Administration > Tables > PMIS > Category

This step is optional.

This page is used to create and maintain a list of LEA-defined category codes to be used for
Position Management. The category codes can be assigned to positions to allow for easier
inquiries. There are no calculations done based on the category. The codes are strictly for
Position Management and do not impact any other system. Categories can be used in User
Created Reports; however, they are not available in any other report parameters.
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CATEGORY

Starting Categary l'_'-'_*-':l::] [ letrieve ] [ Print

Delete  Category Coda Categary Description
|poos | ACCELERATED INSTRUCTION

(ETUDENT AssEssMEN

I

[pooz | [BiuMGUAL EDUCATION
J
J

! et B

[SPECIAL ED AIDE

3. Update first pay date codes.

Use the following pages to establish the current and next year first pay dates and codes.

District Administration > Tables > PMIS > First Pay Date > Current Year

This tab is used to create and maintain a list of codes associated with current year pay dates
to be used for Position Management. The codes are used:

o To establish an association between a table ID and a starting pay date.

o To establish a start date for a new teacher so that a new teacher can be paid over 13
months.

o To determine the first pay date of the new school year when calculating the amounts
already paid to an employee.

o To calculate the amount to be paid to an employee during the change-in-compensation
processing.

o To update the payroll data with the data in the forecast records, and to move the
forecast data into the current position records.

In this example, the first pay date codes begin with J, A, or S to represent the first pay date
month (July, August, or September). The subsequent two characters represent the calendar
code. Codes can be a maximum of three characters and any letters should be uppercase.
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Save |
CURRENT YEAR  NEXT YEAR
Starting Pay Datet‘odeCl i Retneve 1 Print
Delete  First Pay Date Code  First Pay Date Description
® [a1 ] [esasa0p | | ]
[a7 ] [08-25-20 ] [TEACHERS ALG START ]
el [aap ] [08-25-20 :] [207 pavs ]
[sF1 ] [0e-z5-20 ] (197 Davs cn DIRECTOR ]
= [aFn ] (68-25-20; ] [220 ]
[arr ] [o8-25-20 ] [ |
i [we ) [0s2s-200 ] | J
[anu ] [os-zs-20 ] | |
T [ao1 ] [o8-25-20. ] [197Davs ]
[po2 ] [08-25-20 J [203 DAvs ]
o [poa ] [ce-25-20 ] [195 Davs ]
T [apD ] [os-25-20 :] [ |
i) [ApF ] [o8-25-20 ] [197 Davs ]
[ars ] [08-25-20 ] [220 Davs ]
o [l12 i [o7-25-20 :} [cusTrainT 281 HOLIDAY ]
(18 ] [o7-25-20 ] [TEACHERS MUY START |
o [1ac ] [07-25-20 ] | ]
ke ]  [oraszl ] [2260mvs |

Complete the Current Year and Next Year tabs. The Current Year tab represents the first pay
dates for the current school year, and the Next Year tab represents the first pay dates for the
next school year.

District Administration > Tables > PMIS > First Pay Date > Next Year
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.| )
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) ) | 1
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4. Set up action reason codes.

District Administration > Tables > PMIS > Action Reason

This page is used to create and maintain a list of action reason codes to be used for Position
Management.

An action code is required when a change is made to a position record that creates a

historical record. Action Codes for termination transactions can be cross-referenced with the
Termination Reason Codes on the Personnel > Tables > Job / Contract > Termination Reason
tab. Be sure to consider LEA-required data and statistics when creating action reason codes.
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S
ACTION REASON
Startng ActionReason{ || Remeve | Print
Delete  Action Reason Action Reason Description Termination Reason Termination Description
[ 01 | [EMPLOYEE vACATED 575 I |
[ 02 ] [cHencEINPOSTIONINFO(SYS) | |E
(03 | [EMPLOYEE MOVED INTOFOS (575) I J§
[ 0a ]| [ASoFEnD-OF-vEA ] )¢
[ 05 ] [ASOFFRST-OF-TEAR 575) i i
(06 ] [Resigned | i
(@ ) [Frometen ]| |
[08 | [Remove Supplement [ |
) [ | [NewHire ] [ o2 3 Left the employment market for persanal reaasons
[10 ] [Added Supplement | |
B (11 ) [Geest [ |3
(12 ] [Demoten | |3

5. Set up inactivate reason codes.

District Administration > Tables > PMIS > Inactivate Reason

This page is used to create and maintain a list of inactive reason codes to be used for
Position Management. When a position is changed to inactive status, you are prompted to
enter a reason, which is saved in the historical records.
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INACTIVATE REASON

Starting Inactivate Esas{:-"u{:] [ Retrigve ] [ Print

Delete  Inactivate Resson Inactivate Heason Deseription
[ AT ] [ Attrition J
[ Ma ] [extranile |
[ sM ]  [Student Mumbers |
A

6. Transfer positions from one first pay date code to another.

District Administration > Tables > PMIS > First Pay Date Forecast Conversion

This page is used to change a start date code to another for forecast conversion, and should
only be used if you need to transfer all positions from one First Pay Date Code to a
different First Pay Date Code. All positions tied to the From Start Code will be added to
the To Start Code. For example, the program could be used to update the first pay date

code when a new hire employee on a 13-month pay date cycle needs to convert to a regular
12-month pay date cycle.

FIRST PAY DATE FORECAST CONVERSION

Starting Pay Date Cc\de::] l Retrieve ] l Print
Delete From Start Code From Start Code Description To Start Code To Start Code Description
] iTC ] 187 Days (25 pmts) 3 187 Days (24 pmts)
i Jco i July Payroll ] 157 Days

7. Update the forecast conversion data.
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6 Prior to completing this step, the calendars and pay dates must exist in the next
year payroll files.

District Administration > Tables > PMIS > Forecast Conversion

This page is used to create forecast data for the next year's records. This table maintains the
data conversion information by the First Pay Date Code for the Calendar Code, Begin
Date, End Date, Payoff Date, Max Days, Number Of Days Off and Actual Payments.
These fields should be updated with the dates to be used for the next school year. From this
data, the appropriate calendar data is located and the following calculation is performed: The
Local Begin Date is subtracted from the Local End Date, and then the Number of Days
Off is subtracted resulting in the number of Actual Days. This data is moved to the next
year's records at the time the budget is created for the next year.
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(sre )i [ ]: )3 [ca- 1030272 ] [os1e-20m3 ] | FHHE 180] 0g] | 180] | 12
o | o B | e | G | I e | B —s 3|
E ) B | e | o [ D | B | ST | S—)
= B C [Tozmn ) [Eews ) ( i 3 50 9 | 5|
E_J: E_J: (i e wr (@ormz ) (avmm ) | ) =) ) =9 5|
(n Ji 1z 158 | ] (07012022 ] [06-3¢ ] Ji 251 [ o00] [ 251) [ 12]
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For each pay date code, complete the fields on the page. The next year begin and end dates
must match the new calendars in the next year payroll files, and the payoff dates must exist in
the pay dates table for each first pay date code.
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This process updates the table and replaces the mass updating process that is done in the next
year payroll.

The Days Off field is used to reduce the days worked without tying back to unavailable days on
a calendar. For example, a district police officer may work every day (or have the potential to
work every day) but may have a certain number of days off per year that can be taken at any
time.

Import Position and Distribution Data

1. Import checklists.
After the setup steps are completed, use the following checklists to import position and
distribution data.
Import Position Data to PMIS Checklist (prints separately)

Import Distribution Data to PMIS Checklist (prints separately)

2. Verify imported data.

Use the following reports to verify that the records were correctly imported to the current
year Position Management.

O Generate the Position Management > Reports > PMIS Reports > HRS8050 - Position Listing
by Campus report to verify that all positions exist with accurate information.

The report provides a list of all positions within a campus. The report is sorted by campus
number and includes each job position along with a position number, billet number,
description, employee number, employee name, percentage of day worked, and pay
frequency.
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k d W

Dt Pl Pomstion Listng by Campuns Progeam: HRSS050

by Dt -] Fage: 1ol w

dLagai

Pronsticn Wi Buallet hir Poaition Description Fing (B Wl [Erglerpns Hama Pt Wkl

PEHT Q00m CRIMINAL JUSTICE ] Q000Es 10000 %
LT SO0 Solball Masd L1 00 G004
PSHI408 Q0003 SECONDARY SPECIAL 5 20 = 00000 %
S8 T Q004 Specsl B4 ] a0 000 %
HEeCH WU Chewr Sponsor 5 2001 Do0%
PEH1408 200 SECORDARY ART 5 20115 100000 %
PEH1401 Q0002 BECONDARY EMGLIEEH 5 01 plo=livk
SEMY W ol Ghued L] [=r=rhly Q00 %
SoREE ] Baseball Head 5 =0 x =1k
BEHOC Q000 Feariball Offes Cognd 5 OO0 U
PEH4OT Q0001 SECONDARY FOREIDH ] Q000 3 00 D0
GEaCh SO00E  Chesr Sponsor ] f00gs T =1
PEATIES 2000 DHE Reapienat £ O0DE islie

O Generate the Position Management > Reports > PMIS Reports > HRS8054 - PMIS/Payroll
Discrepancy Report to verify that there are no discrepancies.

The report allows you to print a list of all positions that do not have payroll records or a list of
payroll records that do not have position management records.

4 ¥
Dhles Fus PMIS T Payroll Dhscrepancy Repor Progran: HIRSEA
sty Dt i Page 1 ol B
ddy L] Corgeanson
Pom Bdlet
Freg TP Fomition Nix [ Demcriplion Emp Mbr Fmpskryen Mame Mravign
5 P PEMI454 0003 TEACHERS AIDE DOES Dz ot Barwn the sama job codes or extra duty
eoded i CYR Payral
] g S5a0 Q0003 Assocates Degies 000183 Dicerg reai Baree the 8ama b COSeS O eniin duly
codes = TVR Payrod
- P PSMTE05 L0003 SECONDARY READING D0 u Dicmg not barew the same ob codes or axtrs dety
codes n CYR Payrod
5 P PSEVIS4 0004 TEACHERS AIDE DODENE Dz st Barws th sar ok codes o extin duly
ended = CYR Payrel
& P POIMMM 0001 CRIMINAL JUSTICE [k ) Does nead Parwe e same b Codes O exirp duty
codes & CVR Payrod
5 & G5HEH 0001 Schtal Head bo03ES Dicasn nict Barew tha sama ok codes or exbre dusy
rodes m CYR Payrol
5 P PEEI451 0001 EECRETARY FEIME CLERK DOOZH0 Dicsta oot Birws the saew ol codies or axtin duty

O Generate the Position Management > Reports > PMIS Reports > HRS8053 - Midpoint Salaries
Exception Report if your LEA uses midpoint.

This report provides a list of positions that have salary rates that are not within the minimum
and maximum salary ranges.

A "I
LEE Mchpoand Salanes Enoapion Heport Prosgran: HITEBIND
ity Diai: ED Paga: 1ol 1
[Poaition - Ballet Hos Emplryen Hama Emp Ntr  Freg  HoulpTieily Rete e/ Siallary Exncpton Mossagn

PSAT03 - 00001 OGEE 5 243 TEY F30.000 Drady Rate > Maxirwuss Salary
PSAY105 - DO001 OO0ESS 5 405 DEg 400 950 Daily Rste > Madeaus Salany
PSEVIT - DOO0 Q0051 5 354,100 354006 Dady Rate > Mao=us Salary
PSE1IS = 00007 QO0Z24 5 V18400 116.000 Daly Rate > Maosuss Salany
PSH 1807 « D000 Q0038 5 354,100 354096 Dty Raste > Maorswuss Salary
Enel of Flnpon

O For additional information, use the Position Management > Inquiry > PMIS Position Inquiry
page to perform a position inquiry.
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’ Retrieve

J{

Print ]

Position Description: [ CHILDCARE PROVIDER

i

Position Nor: [PSD1802

Pay Concept:  Midpoint EEQOC: 16 Workers' Comp: B TRS Member Pos: 03 Max Days: 217 Max Payments:

Supervisor: Position:  Billet  Employes Mumber™ame:  not occupied

Ignore Pct Day Employed for Salary Cales: M lgnore Pet Year Employed for Salary Cales: N

Details Position Description Position Mumber Billet Mumber Position Type Status Freq Employes Nbr Employee Hame Campus
jo) CHILDCARE PROVIDER PSD1802 00003 Position Artive E 000434 773
(9] CHILDCARE PROVIDER P5D1802 00001 Position Active E 000719 773
[e) CHILDCARE PROVIDER PSD1802 00002 Position Active E 000830 773
Occupant
Employee Nbr: 000434 Employes Name:
Primary Job: ¥ Increase Eligible: M
Pay Grade:  2FG Hourly Emp State Step:  Begin Date: 07-28-20°7 EndDate: 06-28-20  [Payoff Date: 07-30-20
Days Off: 0O NbrDays Employed: 217 Hourly/Daily Rate: 10510 Salary: 13,24530 Remaining Payments: 24
Pesition
Status: A Frequency: E SchoolYear 20
Category: Supplement Attached: M
Job Code: 1802 1stPay Date Code: APR Calendar Code: DC Primary Campus: 773 Dept
Hours Per Day: 8.0 Percent Day Employed: 100 Percent Year Employed: 100 State Minimum Days: O

24 Owvertime Eligible: v

Perform PMIS Maintenance

Log on to the next year.

1. Delete next year PMIS.

Position Management > Utilities > Mass Delete Forecast Positions
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T T
Select Positions only (F). Supplements only {S) or blank for ALL: D
Selact Fosition Statuses or blank for ALL: [ ] :]
Select Position School Years or blank for ALL: [ ] :]
Select First Pay Diate Codes or blank for ALL: [ ] :]
Select Extra Duty Codes or blank fior ALL: [ ] :]

Select Positions or blank for ALL:
{Includes ALL billets for selected positions [ ] :]
Blank for ALL mot processed when Positions/Billets selected)

Select Positions/Billets or blank for ALL: ( ] :]

Selact Supplement Positions or blank for ALL:

{Includes ALL billets for selected supplement positions [ ] :]
Blank for ALL mot processed when Supplements/Billets selected)

Selact Supplement Positions/Billets or blank for ALL: [ ] :]

Year: M

O Leave all fields blank and click Execute. A list of processing reports is displayed.

[ Process h{ﬂ ]
Processing Reports
Selact Report Mame
Mass Delete Forecast Positions Process Error Listing
hass Delete Forecast Positions by Employee Mame
Mass Delete Forecast Positions by Campus
Mass Delete Forecast Positions by Position/Billet
[ Generate Reports ] [ Select AlL ] [ Umnizelect All ]

O Select the reports to generate, and print or save the reports.

O Click Process to delete the forecast records. You are prompted to create a backup.

2. Copy current year positions to the next year.

Position Management > Utilities > Create Forecast Positions

2026/07/10 16:46 17 pmis_initial_setup_new_users


https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_massdeleteforecastpositions.jpg?id=academy%3Apmis_initial_setup_new_users
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_massdeleteforecastpositionsb.jpg?id=academy%3Apmis_initial_setup_new_users
https://help.ascendertx.com/test/business/doku.php/general/pmis_backup
https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/createforecastpositions

Business

Include Proposed Positions:

Move Forecast Conversion Actual Payments to Position Max Payments:
{Also includes remaining payments if Position occupied)

Move Forecast Conversion Actual Payments to Supplement Max Payments:
Reset Supplement Amounts based on Extra Duty Code Table Default Amount]
Move Forecast Conversion Max Days to Supplement Max Days:

Move Supplement Max Days to Supplement Extra Days (occupied only]:

Move Supplement Max Payments to Supplement Remaining Payments:

PREEEE 8

If an LEA has the Percent of Year field set to less than 100% of the stipend

amount on the Position Management > Maintenance > PMIS Supplement Modify >

Position Record tab, they should consider whether or not to select the Reset

Supplement Amounts based on Extra Duty Code Table Default Amount
é ., field.

If the Reset Supplement Amounts based on Extra Duty Code Table Default
Amount field is selected, the amount on the supplement position record is reset to
match the amount on the extra duty table.

O Select all fields and click Execute. A list of processing reports is displayed.

[ Process h ncel l

Processing Reports

Select Report Mame

Create Forecast Positions Process Ermor Listing
Create Forecast Positions by Position/Billet

[ Generate Reports l [ Select All l [ Unselect AlL

O Select the reports to generate and print or save the reports. Verify any errors and make
corrections as needed.

O Click Process. You are prompted to create a backup.

3. Update the fiscal year for distributions.
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Prior to completing this step, verify that the new year budget is initialized in ASCENDER.
Position Management > Utilities > Update Fiscal Year by Fund

O Select the fund/years to be incremented. This process increments the position distribution
fiscal year by 1.

[ Retrieve l [ Execute h

UPDATE FISCAL YEAR BY FUND

Increment Fiscal Year by 1

Increment Fund/Year

(O Click Execute.

4. Generate the Position Listing by Campus Report.

Position Management > Reports > PMIS Reports > HRS8050 - Position Listing by Campus

Generate the Position Listing by Campus Report from next year Position Management to
determine the following:

o If any employees need to be moved to a different position.
o If you have vacant positions you need to update with employee information.
o If you have any supplemental positions that need to be updated for stipends.
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M4 » M

Date Run: Position Listing by Campus Program: HRSB0S50

Cnity Dist: ISD Page:1of 11

Campus

Position Billit Hbr Position Description Freq Emp Hbe Employee Hame Pct Worked

EXTRADUTY 00002  FROZEN CARRYQVER 3 000026 0.00 %
PTEACHER 00205  ENGLISH g 000028 100.00 %
ATHLETICS 00015  BASKETBALL ASST 3 000027 0.00 %
ATHLETICS 00098  TRACKASST 3 000027 0.00 %
ATHLETICS 00113  VOLLEYBALL ASST 3 000027 0.00 %
EXTRADUTY 00005  FROZEN CARRYQVER g 000034 0.00%
EXTRADUTY 00006  FROZEN CARRYOVER 3 000041 I 0.00%
PTEACHER 00606  SOCIAL STUDIES 6 000041 100.00 %
PCAMPUS 00114  AIDE 3 000048 100.00 %

5. (If necessary) Transfer positions from one first pay date code to another.

District Administration > Tables > PMIS > First Pay Date Forecast Conversion

This page is used to change a start date code to another for forecast conversion, and should
only be used if you need to transfer all positions from one First Pay Date Code to a
different First Pay Date Code. All positions tied to the From Start Code will be added to
the To Start Code. For example, the program could be used to update the first pay date
code when a new hire employee on a 13-month pay date cycle needs to convert to a regular
12-month pay date cycle.

Save

FIRST PAY DATE FORECAST CONVERSION

Starting Pay Date Code::] [ Retrieve ] [ Print
Delete From Start Code From Start Code Description To Start Code To Start Code Description
ATC i 187 Days (25 pmts) H 187 Days (24 pmt=)
ICO H July Payroll SHC H 197 Days

Add

6. (If necessary) Update regular and supplemental positions.

Note: If your LEA comes across a situation where teachers are not being captured in the
ASCENDER Student system for grade reporting or scheduling, contact your regional ESC
consultant for guidance.
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Position Management > Maintenance > PMIS Position Modify or PMIS Supplement Modify

oo Nmbae[FTEATHER |1 Potition Deserption| TEATHER Ji [ renen
Dty Bitlat SShYR  Descripton STl Freg Emp N First Naims Mt el Lt Nard Gen “
[@] D000 024 [TEACHER | F
o010 024 [ARTS | F

= 0010 0 [ATs & FLOF ] 3 001179 WANDA MARIE WILLIAMS

0 00103 | 2024 [aATS ] 'y F DDLIS5  WENDY CHARLES WILSON

0 oiiod 2024 [anATs ] F O00TIE  MELISEA MEW EMPLOYEE

- i 024 [SOEMNCEHALFT ] A F  oDiioe HITHE v o

POSIMION RECORD DISTRBUTION DATE BUDGET

Cocupant

Emgl Ibe 5 Ernglergig Mane HAR
ry Job :--. ase Elgeie D-_.Al' e D
cce [y oo GE N Sevwite (i s o (5] epn0n: (o505 ) e oo |
. [ 08) Mo Doy Employes: 18200 bourDiaty st [ 355.158] St iring Payeene: [ 12) o

Postion

coept Changes Sramus. [ .

o Code: [1000 - TEACHER Ji meec [
Per Day: [_0.000) Percent :

pr Annud EEDC.  Wiork Mg ligitde: [
[ ]

If working on the Distribution tab, you must select an account code from the
autosuggest drop down in the Account Code field versus typing in the full
account code in order to validate against the grant code table.

If necessary, use one of the following options to vacate an employee from a position:

O Option 1: It is best practice to use the Position Management > Utilities > Vacate Employee
from Forecast Positions page to vacate a position.

Typically, when an employee decides to leave the LEA at the end of the year, the employee is
paid off in payroll at the end of their contract; therefore, no additional action is necessary for
the current year. However, in the forecast records, the employee must be removed from all
existing positions.
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Save jﬁ
VACATE EMPLOYEE FROM FORECAST POSITIONS
e 5 !
Wacats | Dotads Accept Chis  Podition Typs  Podition Mumber Prriition Dird rigtion Balst  SchYR Jobr T Sawtus
o L PEBAADLT LEAD WELLMESSPE FACILITATOR. | 00001 3035 AZ17-LEADWELLNESS FACLITATOR A
o & s SEATY TRAVEL 00000 2026 A
Croupart Indorraton
Job-Code: [A217 - LEAD WELLNESS FACILITATOR ] Primary lobc [f]  Percent Day Employed Percent Year Employest
Pay Concent padpaint Pary Gradse: [l-_u, Contracted emp  State Siep E] Begin Date: [(07.15-2024 | End Date [u-; 132025 | Payolf Date ['ug?f;;;_--,
o Dy 210.0| Dawe O ) Mo Doy Employed: 21000 Howrs Per Doy, T FosaryTiaily feate: B84 688 | Actusl Salary: @0 784 00 Remaining Paymant:: 12
Prmary Campu: (303 - 903 School Dept: (] Colendar Cete- (T8 | TRS Member Pert: ([ - Professional stat | trer Eligitda: 7]
(Distribation bvioimaton
Ativity Code Aroourt Code Grant Coda Warkers' Comp Expense 373 Ergiayer Contribafion Parcent Amaurt Dp At
- (e i3enso0mss1io0 A | = 70000 5654880
- [101-35-6115.00-938- 569000 | A | [Somea) 20
Totalz: 100000 BOTE400

o Retrieve the employee's position record.
o Select the Vacate check box for each position.
o Click Save.

O Option 2: Use the Position Management > Maintenance > PMIS Forecast Change page (only
available in the next year payroll) to change an employee from one position to another. A list of

the employee's existing positions is displayed with a section to either enter a new position or
vacate a position.

Current Forecast Positions,
Duotails Prosarinn Summber Perumssn Description Biles Sl YR Job Code: eatus
o PTEACHER SOCIAL STUDES o06a7 2024 1000 - TEACHER A

Primary Job Percent Doy Emgloyed EI Percent Year Employed £ sruilate
L P Pay Step 1 Schedule Dg Saate Step E] Begin Date: [08-03-2023 | End Date [05-23-2024 | Payolf Date
VE D ON '.':.- Days Emgloved: 183 00 Houwrs Per Day HourlwDaiy R 204 011 | Acual Salary: 53804 D0 Remars

0 Rema
Primary Campus: [001 - D01 School J: Dert D'.‘:..m:u- Code: 10 TRS Member Pos: (17 - Teacher, borarian incr Pay Step £
Drstribeston infarmation
Ddete Actrvity Cote Account Code Geart Code Wiorkers' Comp Expense 373 Employer Contrisution Percent Arnoeant Dup Acct
B |z'_- Hasze Salary v] |".3~:- 11-611900-001-41 1000 A 538000
Toxati 100,000 5380400
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7. Generate the PMIS/Payroll Discrepancy Report.

Position Management > Reports > PMIS Reports > HRS8054 - PMIS/Payroll Discrepancy Report

Generate the PMIS/Payroll Discrepancy report to determine if there are any active employees
not assigned to a forecast position. Below are some examples of the PMIS/Payroll Discrepancy

report:
Dot P PMIS. ] Paryeoll Discropancy Report Program: HRSEGL
Criby Dt 0 Prage: Tl 9
b Ll Companson
ot
Freg T Provatin M el Dscrption g M Ernploryn Mo Mrvenm
E P PSAINR 00007 ADMBESTRATIVE [ L] Does: roct harve the same jobrcodes or exira duty
codes in TR Paryecl
E P PSAIND 00007 DR OF TECHMOLDGY o0oess Cots nat harve the same job codes o exir duty
oodes in TR Payecl
E P PSATIOE 00007 TRANSPORTATION COORD [ F ] Do rict b S s jobs codes or endra duty
codes i OV Payscl
E P PSAING 00001 BURSINESS MANAGER DOCEES Doss not have e same joboodes o exirs duty
codes in CYR Payscl
E P PSATIE 0000 DIRECTOR ATHLETICS [ ie o] Do rict havs S savmas jobs codes o endra duty
oodes i CYR Payecl
E P PSINT CO001 PEIMS COORDINATOR ooctag Coes rect harve tha same jobcodes o extra ety
codes in OV Payecl
E P PSRN0 00007 FACILITIES CeRECTOR 000872 Does nct have the same job oodes or exdma duty
Date Run: PMIS | Payroll Discrepancy Report Program: HRS8054
Cnty Dist: 5D Page: 1 of 1
Employes Level Comparison
Pos Billat
Frog TYP Position Nbe Hbr Dwacription Emp Mbr Employes Mama Mosango
F P PCAMPUS DO300 PRINCIPAL 000012  ADKINS, ALEXANDER LYNN Inactive in CYR Payroll
& 001140  BUSMGR, IMA Active emp not assigned 1o Forecast Position
6 000&31  POER. PACER P Active emp not assigned 1o Forecast Posithon
] 001058 WHARTONM, TYLAR DEMAA  Active emp not assigned to Forecast Position
6 001120 WILLLAMS, WENDI IRENE Active emp not assigned 1o Forecas! Position
[ 001134 WYNN, WYOMING Active emp not assagned 1o Forecast Posdtion
] 001135 YARBROUGH, TACHARY KAY Active emp nol assigned to Forecast Position
8 001138 YOUMNG, ZEB MARTIN Actrve emp nol assigned Lo Forecast Position
L] DO1138 ZAPATA. ZOMA ASHLYMN Actrve emp nol assigned 1o Forecas! Position
Total Number of Employees 9
End of Report

8. Generate a user-created report.

Position Management > Reports > User Created Reports > CYR/NYR Positions

Generate a PMIS user-created report to verify that the Increase Eligible field is selected for
applicable positions. It is possible that the field is not selected for new LEA employees from last

year.

O It is recommended to verify the Nbr Remain Payments field prior to calculating salaries.

O Select the following fields on the user-created report:
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[ Save ] [ Create Report ] [ Delete ] [ Reset ] Year; C e

PMIS Position/Distribution Export File Auta Select Options

D PMIS Pogition Control D PMIS Position Distribution

DPMIS Pasition Control

[ JCYRMYR Flag [ contract Beg Date [Jpay Empld Pet [JExtra Duty Code

ition Mbr [ Contract End Date Pt of Year [ 5upplement Type

it D Payoff Date DPE‘- Concept D Supplement Max Amt
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D Ign Pct Day For Sal Calcs
[Jtan Pet ¥r For Sal Cales
[ Mew Employee

|:]I'K.-r. on School Year I Mbr Remain Payments I 3 Gﬁ::ost Change Midpoint Base
DF.':—:,encT |LJlab Catzgary DMB:\ Payments D Date Create/Update DPe'cmt of Midpaint
DG.'_: Employee Mbr D Supplement Attached DU-.-'.'.’ Elig Fig B Date Fill Duﬁe/‘"alc-,-me'.t Elig Flag
[ ]Primary Job ek Code [J5tate Minimum Days [JFill Pesition Reasen [JFica Elig

I’.:'ease Elig D 1st Pay Date Code DSaus' Position Mbr G Date Criteria D._-_lS Status Code

|J O Pay Grade D Calendar Cade DSavs* Billet Mbr D Drate Authorization DBch_: et Amount
DCL: Fay Step D Campus I DSupo.eme nt Extra Days D Date Authorization End DBng et Salary Override
[JOec Fay Schedule e [J5upet to Pos Mer [Joate Entry [O#cwaliBudget Ind
DSta:e Step Dl—rs Per Day DSJp-o.tc Pos Billet DDEte Inactive DPE‘- Type

DPMIS Position Distribution

[JCYRMNYR Flag [Jiek Code [JFunction [JEd Span [(JExpense 373
Dl"csi: on Mbr D;‘\ccsu nt Type D Object D Project Detail DC.:.ﬁ'.‘iI:- At Flag
DE Llet Nbr Df‘av Activity D Sub Object Dh‘.ccun: Ameount
Dr‘csizjn Type D'v‘.'c'ké's Comp D Organization D;*u'_:cun: Percent
[ vistribution Segquence OFte D [ Fiscal Year [ TRs Grant Code
DFreq_encT DFunc D Program Intent D Extra Duty Code

DEmplwae Demo

DMJG[;—N:.-“;— D-Ge'.era:ic'.

O Click Create Report. The report is displayed. Use the sort/filter functionality to group the
applicable data.

Note: The number of remaining payments reflected on the report is displayed on the Job
Info tab as the number of annual payments and the number of remaining payments for the
employee for any P position type. If the LEA uses S acct types or business allowances for
extra duties, S position types on this report should reflect the correct number of remaining
payments. Prior to continuing, make the necessary position corrections.

9. Update position records.

Position Management > Maintenance > PMIS Position Modify > Position Record

If necessary, update the Increase Eligible field to identify the employees who are eligible to
receive a salary increase for the new school year when running simulations. Only the employees
with this field selected will receive a salary increase.
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O Clear the Increase Eligible field for new employees who are not entitled to a salary
increase. Remember that the next year Position Management pay step reflects the same

current year Position Management pay step, and the step is increased in the salary simulations
if the Increase Eligible field is selected.
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O If necessary, update the New Employee field to identify new employees on forecast position
records. If selected, the salary simulations will budget the employer contribution for new
employees even though they do not have current year payroll records.

Notes:
This field is not displayed on supplemental position records.

If the position is changed to any status other than Active, the field is disabled.

O Clear this field If an employee is no longer new to the LEA.

Position Management > Maintenance > PMIS Position Modify > Budget

If there are retirees who work in the LEA, confirm that the TRS Status field is set to 5 - Retired.
If the TRS status is incorrect, there is a possibility that the status will be incorrect (TRS-eligible)
when the employee is moved to the current year payroll.
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Vacancy/Budget Information

Pay Grade: |30 |: Pay StepfState Step: D Mon-Contracted emp  FTE:
Midpoint Base: Plus Percent of Midpoint 0.00
Unemployment Eligible: FICA/Medicare Eligible: [M - subject to medicare v | TRS Status: [" - Retired v]

Update NYR Positions and Move 10-, 11-, and 12-month
Employees to CYR Payroll

¢ 10-month Employees
e 11-month Employees

e 12-month Employees

Interface to Budget Checklist

Checklist
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